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Obtaining 
Permissions

Authors must request permission to use/reproduce figures and tables from other 
sources. Reference all materials from other sources where they appear in your 
manuscript.

Classify all references to another source’s 1.	 information as either “in the 
public domain” or “requires copyright permission.”

Publications from •	 federal agencies are all in the public domain, which 
means the information must be cited in your text and referenced at the end 
of your manuscript but you do not have to request permission to use it.

Material from •	 private publishers requires copyright permission—if 
permission is not granted for you to use the material, you cannot use it 
in your manuscript. 

For all photos, figures, tables, and data from tables from other sources »»
that require permission, you must cite the source in your text and 
reference it at the end of your manuscript.

NOTE:•	  Table data do not require copyright permission as long as the 
table is reformatted. However, the material must still be cited, so refer-
ence information is required.

For those sources that are not in the public domain, 2.	 request permission from 
the copyright holder to use/reproduce the information.

Submit the request letter to the copyright holder and ask for a reply within •	
30 days. The organizations should reply directly to you.
To request permission to use ASHRAE copyrighted content, visit   •	 ASHRAE’S 
website.

Permission to use/reproduce material 3.	 must be obtained during the writing 
stage.
Submit permission-granted letters with the 4.	 completed manuscript. No editing 
or layout work will begin on the manuscript until all permissions have been 
received.

http://www.ashrae.org/permissions
http://www.ashrae.org/permissions
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Copyright

ASHRAE retains exclusive copyright of papers published in HVAC&R Research 
and ASHRAE Transactions. Works published by ASHRAE are final and complete 
works.

Under ASHRAE copyright policies, authors retain the right for certain specific 
uses of their paper without requesting ASHRAE’s permission. Only the “as pub-
lished” version of the paper may be used by the author. These uses are as follows:

to make copies of the paper for their own •	 personal use;
to •	 make copies and distribute copies of the paper to researchers or cus-
tomers of the author’s employer for the personal use by such researchers 
or customers;
to post the paper as published by ASHRAE on the author’s personal, •	
institutional, or corporate website or server with a link to ASHRAE’s 
website;
to present the paper (after ASHRAE publication) at a meeting or confer-•	
ence and to distribute copies of such paper to the delegates attending the 
meeting with written permission from ASHRAE;
to allow use of the paper by the author’s employer for posting on the •	
employer’s Web site, for use by the employer in training or educational 
courses offered by the employer, for internal research work that is con-
ducted by the employer, and for internal publications published by the 
employer;
to include the paper in full or in part in a thesis or dissertation;•	
to include the paper in a printed compilation of works of the author, such •	
as collected writings or lecture notes; and
to prepare other derivative works, such as extending the paper into book-•	
length form, or to otherwise re-use portions or excerpts in other works, 
providing there is acknowledgement of its publication by ASHRAE. 

Other uses must be authorized by ASHRAE. Authors should contact ASHRAE 
explaining their specific need and identifying the paper and ASHRAE publication 
in which the paper appeared.

Others wishing to use ASHRAE copyrighted content should visit ASHRAE’s 
website for more information and to make their request.

http://www.ashrae.org/
mailto:permissions@ashrae.org
http://www.ashrae.org/permissions
http://www.ashrae.org/permissions
http://www.ashrae.org/
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Formatting 
Figures

Original figures or other artwork should be submitted with the manuscript 1.	
whenever possible. For information on reprinting a figure from another 
source, see Obtaining Permissions.

Use only 1 point (0.014 in. [0.35 mm]) or thicker lines—smaller lines will 2.	
not reproduce well.

Figures to be reproduced in black and white should use 3.	 patterns or shapes 
to distinguish sections instead of coloring and shading. Figures to be repro-
duced in color should have touching colors that differ significantly so that 
there can be no confusion in understanding the data.

Each figure should have a brief legend or 4.	 descriptive labels, as appropriate. 
Any text included in a figure (except the figure caption) should be em-
bedded as part of the image file and not contained in a separate text box 
that is not part of the image file.
Provide 5.	 dual units for all measurements, preferably as two sets of figures.
Figure files should be clearly labeled (i.e., Figure1.tif, Fig2.tif, Fig3-2, etc.). 
Multiple-part figures, such as a figure with parts (a) and (b), must be submitted 
as one file with all parts included.

All figures must be provided to ASHRAE as individual TIF (preferred) or 6.	
EPS files in either CMYK mode (for color) or Grayscale mode (for black 
and white) saved at high resolution (600 dpi or greater) and at least 4 in. size 
or greater. See Converting Excel Graphics or Converting Word Graphics for 
instructions on graphic conversion.

Every figure must be referenced in the text by name/number, where “Figure” 7.	
is capitalized (e.g., “…as shown in Figure 2.”). 

Figures must be numbered consecutively as they appear in the text.8.	

Prepare a list of captions for figures and place it at the end of the manuscript 9.	
(this applies to papers only!).
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Formatting 
Tables

All 1.	 table titles should be descriptive but concise.

Original tables should be submitted with the manuscript whenever possible. 2.	
For information on reprinting a table from another source, see Obtaining 
Permissions.

Titles appear above the tables, and every major word in the title is capitalized.3.	

Number tables consecutively and in the order they are mentioned in the 4.	
text. 

Tables used in the manuscript should 5.	 not be image files but alterable tables 
(such as those created in Word, Excel, Framemaker, InDesign, etc.).

Use only 1 point (0.014 in. [0.35 mm]) or thicker lines—smaller lines will 6.	
not reproduce well.

Vertical and horizontal lines should be avoided except to delineate the top 7.	
and bottom of a table and to separate the heading row from the data unless 
lines are otherwise necessary for clarity or organization of the data.

Label each column with a heading and include units of measurement and 8.	
other necessary qualifying information. Units should be set off with a com-
ma (e.g., “Velocity, m/s”).

Provide 9.	 dual units for all measurements.

Every table must be referenced in the text by name/number, where “Table” is 10.	
capitalized (e.g., “as provided in Table 5”).



ASHRAE 
 Authors’ Manual

Units of 
 Measurement

ASHRAE policy requires dual units of measurement—inch-pound (I-P) and 
International System of Units (SI). You are required to provide dual units when 
submitting the manuscript; ASHRAE staff will not convert units for you. Some 
guidelines are as follows: 

The units used in calculating the work being reported shall be listed first with 1.	
the alternate system of units following in parentheses. 

Always spell out all units when they are used without a number.2.	

Do not mix 3.	 symbols and names in the same expression.

Do not express 4.	 plurals by adding an “s”

Do not use 5.	 periods with units of measurement:

EXCEPTION:•	  in. for inch

Leave a 6.	 space between the numerical value and the unit of measurement:

EXCEPTION: •	 There is no space between number and degree of plane angle 
or degrees of temperature (45°, 62°F, 20°C) or the number and the percent 
symbol (5%)

“L” is the symbol for liter, not lowercase “ell” or script “ell.” 7.	

“Centi-” is not an acceptable SI prefix, and 8.	 the use of cm should be avoided. 

For currency, include the monetary unit of the country where the research is 9.	
based followed by the US dollar conversion in parentheses.



ASHRAE 
 Authors’ Manual

Formatting 
Equations

Each significant equation or formula should be displayed on a separate line. Center 
equations and place consecutive equation numbers flush right in parentheses. 

EXAMPLE:
		  a2 + b2 = f2 	 (1)
		  where
		  a2 	 =	 apples
		  b2 	 =	 bananas
		  f2 	 =	 fruit salad

If an equation requires more than one line, break it before an operational sign, 
and align the operational signs on the left.

EXAMPLE:
		  E = (a + b + c)/(m + n + o)	 (2)
		  ×  d + e + f)

If two or more displayed equations are grouped together, leave space between 
the individual equations:
		  a + b = c	 (3)

		  D = f – ab2	 (4)

		  mon + rst	 (5)

Spell out the word “equation” and capitalize it in the text when referring to spe-
cific, numbered equations. In a highly mathematical or theoretical work, consider 
developing equations in appendices rather than in the body of the manuscript.

Please note that all equations must be retyped in our pagemaking program—
this is one reason we require a hard copy of the manuscript—and therefore 
should be checked thoroughly by the author at the proofreading stage.
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Book Publication 
 Process

Most books are the result of an ASHRAE research project. A subcommittee may 
be designated to handle the review process of a committee-sponsored project, uti-
lizing committee members or other persons with expertise in the area of concern.

The ASHRAE submittal, review, and publication process proceeds as follows:

Author(s) indicate intent to submit a manuscript to 1.	 Special Publications 
and receive the Authors’ Manual.
Author(s) prepare the manuscript, including artwork, according to this Authors’ 2.	
Manual and send the manuscript to Special Publications. 

Cognizant Technical Committee selects qualified reviewers.3.	

Reviewers send 4.	 reviews and comments to the author(s). 

Author(s) revise manuscript and/or rebut comments and provide revised 5.	
manuscript or rebuttal to the reviewers/cognizant Technical Committee.

Reviewers complete an additional review.6.	

Review process continues until the manuscript is accepted or rejected for 7.	
publication by the cognizant Technical Committee.

After the manuscript is approved for publication, author(s) submit a final 8.	
Microsoft Word file and separate figure files on a CD to Special Publications, 
and the author(s) are informed of a tentative publication schedule.

Special Publications editors edit the book for grammar, punctuation, clarity, 9.	
and consistency with ASHRAE policies. It is then put into pages, with the 
figures and tables incorporated into the text. 

Editors send a PDF to the author(s). Author(s) proofread the manuscript—10.	
changes should be minor at this stage—within a mutually agreed upon 
(hopefully, short) timeframe. 

Book is published and offered for sale in ASHRAE’s bookstore as both the 11.	
physical, printed book and a PDF available for download.

Each author receives a complimentary copy of the published book.12.	

mailto:mowen@ashrae.org
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Paper Publication 
Process

All papers undergo critical, double-blind review by at least three competent 
specialists to ensure high quality of content. 

The HVAC&R Research review process is coordinated by the journal’s Editor-
in-Chief. The Transactions paper review activity is coordinated by the ASHRAE 
Conference Program Administrator. The IAQ Conference review activity is coor-
dinated by the Assistant Manager of Research and Technical Services. 

The ASHRAE submittal, review, and publication process proceeds as follows:

Author(s) indicates intent to submit a paper to the appropriate publication con-1.	
tact person (see above) and receives instructions and the Author’s Manual.
Author 2.	 prepares the paper, including artwork, according to the Author’s Manual 
and posts the paper online at Manuscript Central. 
The appropriate publication contact person selects qualified reviewers.3.	
Reviewers carefully review paper and then submit online review to the appro-4.	
priate publication contact person.
The publication contact person sends 5.	 reviews and comments to the author. 
Author revises paper and/or rebuts comments and posts revised paper or 6.	
rebuttal online.
The publication contact person notifies reviewers that a revised paper requires 7.	
an additional review.
Review process continues until the paper is accepted or rejected by the Con-8.	
ferences and Exposition Committee (or topical conference organization com-
mittee) for publication.

After the paper is approved, author submits a final 9.	 Microsoft® Word for Win-
dows file and separate figure files online at Manuscript Central, and the paper 
is scheduled for a print issue, for presentation at an ASHRAE meeting, or for 
presentation at an IAQ conference.
Editors edit and format paper and send a PDF to author. Author 10.	 proofreads 
the paper. 
Paper is 11.	 published in either HVAC&R Research or ASHRAE Transactions and, 
if for an ASHRAE meeting, as an individual preprint paper available on a CD 
and at the meeting. 
For ASHRAE meeting papers: Editor sends any written 12.	 comments and questions 
(generated at the meeting) to author. Author returns responses to Editor. 

http://mc.manuscriptcentral.com/ashrae
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Book Submission 
Guidelines

The following materials are required for manuscript submission:

1.	 A CD with the complete manuscript in Microsoft® Word for Windows and 
the figures provided as separate TIF or EPS files saved at high resolution. 
Tables should be editable and NOT submitted as images.

2.	 A laser printout of the complete manuscript including text, tables, and graphics. 
With the printout, include a cover sheet with the following information: 

•	 Proposed title of book

•	 Sponsoring ASHRAE group and/or number of ASHRAE research project, 
if applicable

•	 Author names in desired order with (if applicable) ASHRAE member-
ship grade, academic degrees at the doctoral level, and professional 
certification for each author

•	 An “About the Authors” paragraph

•	 Complete contact information for the corresponding author, including 
mailing address, phone and fax numbers, and e-mail address

•	 Three to five key words from the Key Word List and a paragraph describ-
ing the book (to be used on the back of the book, in the bookstore, and in 
marketing materials)

3.	 The completed Marketing Questionnaire

4.	 See Document Formatting and Book Organization for additional requirements.

Manuscripts should be submitted to:	

		  Mark Owen
		  Editor/Group Manager, ASHRAE Handbook and Special Publications
		  1791 Tullie Circle, NE
		  Atlanta, GA  30329 USA
		  Telephone: 678-539-1187
		  Fax: 678-539-2160
		  mowen@ashrae.org

mailto:mowen@ashrae.org
http://xp20.ashrae.org/Manuscript/Marketing_Quest.pdf
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HVAC&R Research 
 Submission 
 Guidelines

Manuscripts submitted to HVAC&R Research should represent original work of 
lasting significance. They should be submitted exclusively to HVAC&R Research, 
should not be under consideration for publication elsewhere, and should not have 
been previously published. 

1.	 There is no page limit or maximum number of figures for papers submitted 
to HVAC&R Research.

2.	 The paper should include an abstract of 100 to 200 words.

3.	 An author’s list should be submitted as a separate file and must include the 
following:

•	 The title of the paper
•	 Author names in desired order, principal author first, with (if applicable) 

ASHRAE membership grade and professional designations (e.g., PE, 
PhD, PEng, DSc, CEng, DrIng, etc.) for all authors

•	 An author note with job title, affiliation, and address for each author.
•	 Complete contact information for the corresponding author
•	 Authors should NOT identify themselves in manuscript files to enable 

reviewers to maintain a blind review.

4.	 See Document Formatting for additional requirements.

5.	 Download the Authors’ Template for an example paper.

Submit HVAC&R Research papers online at ASHRAE Manuscript Central. 
Please follow the Submission Instructions in the “Instructions & Forms” section. 
Instructions for uploading files to Manuscript Central are also available there. 
Reviews will be done using ASHRAE’s online review process. The correspond-
ing author of a paper will receive complimentary copies of the issue in which the 
paper appears for distribution to all authors.

Assistance can be obtained from:

			   Dr. Reinhard Radermacher
			   Editor in Chief, HVAC&R Research
			   Department of Mechanical Engineering, University of Maryland
			   College Park, MD 20742-3035
			   E-mail: raderm@umd.edu

http://xp20.ashrae.org/Manuscript/AuthorsTemplate.doc
http://mc.manuscriptcentral.com/ashrae
mailto:raderm@umd.edu
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Conference Papers 
Submission 
Guidelines

The typewritten manuscripts for papers submitted to ASHRAE conferences 1.	
and the IAQ Conference (including references and tables) must not exceed 30 
double-spaced pages, and manuscripts can contain a maximum of 12 figures.
An author’s list should be submitted as a separate file and must include the 2.	
following:

The •	 title of the paper
Author names in desired order, principal author first, with (if applicable) •	
ASHRAE membership grade, academic degrees at the doctoral level, and 
professional certification for all authors.
An •	 author note with job title, affiliation, and address for each author.
Complete •	 contact information for the corresponding author.
Authors should NOT identify themselves in manuscript files to enable re-•	
viewers to maintain a blind review.

See 3.	 Document Formatting for additional requirements.

Download the 4.	 Authors’ Template for an example paper.

Submit Transactions and IAQ Conference papers online at Manuscript Central. 
Instructions for uploading files to Manuscript Central are available in the “In-
structions & Forms” section. Reviews will be done using ASHRAE’s online re-
view process. The corresponding author of a paper will receive complimentary 
copies of the issue in which the paper appears for distribution to all authors. 
Assistance and information can be obtained from the following:

ASHRAE Transactions

			   ASHRAE Conference Program Administrator
			   Tiffany Cox
			   E-mail: tcox@ashrae.org 
			   Telephone: 678-539-1137

IAQ Conference

			   ASHRAE Assistant Manager of Research and Technical Services
			   Steve Hammerling
			   E-mail: shammerling@ashrae.org 
			   Telephone: 678-539-1158

http://xp20.ashrae.org/Manuscript/AuthorsTemplate.doc
http://mc.manuscriptcentral.com/ashrae
mailto:tcox@ashrae.org
mailto:shammerling@ashrae.org
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Please use this list as an aid in 
selecting a minimum of three 
and up to a maximum of five 
key words.

A

agricultural applications
air cleaning equipment
air conditioning accessories
air conditioning units
air distribution equipment
air handlers
air pollution control equipment

B

boilers
building automation & controls
building envelope

C

certification programs
chillers
chimneys
clean spaces/areas/rooms
coils
commercial buildings
commissioning
compressors
computers
condensing units
consulting services
controls
cooling towers

D

dehumidifiers
dormitories
drives
ducts

E

economic development
economizers
education
educational facilities
electrical components
energy management systems

energy recovery
environmental test facilities
evaporators

F

fans
filters
fire safety systems
food processing
furnaces

G

gaskets
geothermal products

H

health care facilities
heat exchangers
heat pumps
heat recovery units
heaters
heating accessories
hotels and motels
humidifiers
hydronic heating equipment

I

ice makers
ice rinks
ice storage equipment
indoor air quality equipment & 
products
industrial facilities
instruments & meters
insulation

J

justice facilities

K

kitchen ventilation systems

L

laboratories
libraries and archives

M

motors

museums

O

oil

P

pipes
power plants
public assembly buildings
pumps

R

radiant heating equipment
refrigerant control equipment
refrigerants
refrigerated facilities
refrigerating equipment
research & development
residential buildings
restaurants and hospitality facilities
retail space

S

software
solar equipment
soldering, welding, and brazing 
equipment
supermarkets

T

testing laboratories
thermal storage
tools
training

U

utilities

V

valves
VAV equipment
vibration & noise control

W

warehouse refrigeration
water heaters
water treatmen 

Keyword List
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Sample Figures

“Figures to be reproduced in black and white should use patterns or 
shapes to distinguish sections instead of coloring and shading.”

“Figures to be reproduced in color should have touching colors that differ 
significantly so that there can be no confusion in understanding the data.”
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Sample Table
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Heading Level 
Examples

First Level

Second Level

VOLUME 14, NUMBER 5, SEPTEMBER 2008 797

PERFORMANCE EVALUATION FUNCTION

The performance of any air-conditioning system depends on two factors:

a. thermal comfort 

b. energy consumption

Thermal Comfort

The most important variables that influence the condition of thermal comfort are air tempera-
ture, water vapor pressure in ambient air, relative air velocity, mean radiant temperature, activity
level (heat production in the body), thermal resistance of the clothing, and purity of the air.
Fanger (1970) defined a thermal sensation index by considering air temperature, water vapor
pressure in ambient air, relative air velocity, mean radiant temperature, activity level, and ther-
mal resistance of the clothing. PMV is the thermal sensation index given by Fanger (1970) and
is internationally standardized. It is easy to use PMV when controlling an air-conditioning sys-
tem because PMV is an index of human thermal sensation with one value for all seasons and is
effective for all temperatures that are neither extremely high nor extremely low. PMV ranges
from –3 (cold) to +3 (hot). When PMV is zero, then thermal sensation will be neutral, i.e., nei-
ther cold nor hot. Broadly speaking, when PMV approaches zero then thermal comfort
increases.

The first term on the right-hand side of Equation 14 indicates the mass of moisture in the
incoming air, which comes in contact with the evaporator wall, and the mass of moisture in the
outgoing air. The humidity of the incoming air is calculated from a psychrometric chart with the
help of the second-order curve-fitting method. The multiplying factor, (1 – b), corresponds to
the bypass factor of the evaporator. The second term amounts to mass of moisture in the incom-
ing air bypassed through the evaporator and the mass of moisture in the outgoing air. The multi-
plying factor b corresponds to the bypass factor of the evaporator. The rate of change of specific
humidity of supply air when the evaporator wall temperature is more than the dew-point temper-
ature is given by

 . (1)

The first two terms on the right-hand side of Equation 15 correspond to absolute or specific
humidity of incoming air, and the third term corresponds to outgoing supply air humidity.

Specific Humidity of Thermal Space. The rate of change of the specific humidity of the
thermal space is given by

 . (2)

The first term on the right-hand side of Equation 16 corresponds to the change in humidity
due to the supply air humidity Ws, and the second term on the right-hand side corresponds to
moisture load.

The superheat of refrigerant at the outlet of the evaporator can be expressed as He et al.
(1998):

aVd dWs dt v a 1 – W3 W0 Ws–+=

aVs dW3 dt v a Ws W3– M0+=

SH Tae Te– 1 exp oe Die– Le le– Cpm· com–=

Third Level
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Agreement to 
Publish Notice

ASHRAE requires that prospective authors sign a form that gives ASHRAE 
the copyright and permits ASHRAE to publish the manuscript, to reprint it, 
and to offer it in whole or in part for reproduction or translation. ASHRAE 
must have the author’s written permission and assignment of copyright (for 
papers) before a manuscript can be processed for publication. This might be 
covered by a publications contract or a research project agreement already; if 
not, authors should complete the Agreement to Publish form and either mail 
it to the address or fax it to the number provided on the form or upload it to 
Manuscript Central. Authors shall not submit manuscripts that are or will be 
considered for publication by other organizations or publishers.

It is the author’s responsibility to secure and transmit to ASHRAE written 
permissions for use of proprietary information and/or copyrighted materials 
appearing in the manuscript prior to its submission.

ASHRAE requires previously unpublished papers in all its publications. Prior 
publication of technical papers in publications that are indexed or widely avail-
able from retrievable sources (including ASHRAE Journal and HVAC&R Re-
search) usually precludes consideration for presentation at Society meetings or 
publication in ASHRAE Transactions. 

http://mc.manuscriptcentral.com/ashrae
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Commercialism 
Policy

Commercialism Policy (Recent as of March, 2 2009)

Commercialism is the inclusion of visual, apparel, written, or verbal references to any 
organization for the promotion or commercial advantage of that organization or the 
commercial disadvantage of a competing organization.

The Conferences and Expositions Committee will strictly enforce this policy for 
ASHRAE papers, presentations, and/or research documentation at the ASHRAE Winter 
and Annual Conferences.

What Is Not Allowed

References or displays of trade names, logos or products provided by an HVAC&R a.	
related commercial organization, except as allowed in part (b) below.  
Inference that b.	 ASHRAE approves or endorses any product, software or system for 
any reason, even if the product, software or system complies with an ASHRAE 
standard.  
Copies of papers or portions thereof, draft position papers or recommendations, c.	
brochures, or other information SHALL NOT be made available at ASHRAE trans-
action sessions, seminars, or forums.

What Is Allowed

First slide or presentation d.	 introductions.   
Bibliographies shall be restricted to the last slide or closing remarks.e.	
Research, programs, case studies, statements, policy, and/or legislation from any or-f.	
ganization may be referenced only in order to maintain presentation clarity and rel-
evance. Research, programs, policy, legislation or name of organizations, software, 
government agencies and government-sponsored agencies may be referenced only 
in order to maintain presentation clarity and relevance. Reference to Universities, 
Research agencies, Government agencies, Government-sponsored agencies, and/or 
non-profit organizations shall be allowed as long as the reference is non-biased in 
nature, germane to the focus of the publication/presentation, and does not imply an 
ASHRAE endorsement of a product and/or service.
The g.	 names of computer hardware, computer software, operating systems, browsers, 
word processing programs, spreadsheets, presentation programs, etc. 
Trade or company names and/or logos of h.	 historical nature may be allowed.
Trade or company names and/or logos i.	 NOT related to the HVAC&R industry may be 
allowed. 
Specific j.	 reference may be made to industry-related standards, test methods, and 
codes.
Make, model or sole source of critical test instrumentation, engineering software, re-k.	
agents or apparatus may be identified as a footnote, so that others may duplicate the 
testing.
The last l.	 slide may contain your name.

Policy Enforcement

The Conferences and Expositions Committee coordinates the m.	 review of all papers 
prior to publication or presentation. Nonconforming items within the audio-visual 
material will be deleted from the material or the material will not be allowed to be 
shown at the presentation.
The n.	 technical programs Issues Updates Seminar and Public Session are not reviewed 
for commercialism since they are subject to current topics of general interest.
Exemptions for special cases will require the written approval of the Program Com-o.	
mittee Chair prior to the start of the Annual or Winter Conference.
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Converting 
Excel Graphics

Below are steps for converting figures created in Microsoft Excel into .TIF 
files. For additional information see Formatting Figures.

1.	 In Excel, select the chart or graph to be converted. 
If using Excel 2007:

•	 From the menu options select “Copy.” 

	 If using an older version of Excel:

•	 Hold down the Shift key and from the menu options select “Edit.” 

•	 Choose “Copy Picture” from the drop-down Edit menu. 
•	 Select “As shown when printed,” then “OK.”

2.	 Minimize Excel; open PowerPoint.

3.	 If using PowerPoint 2007:

•	 On the Home tab, click “layout” and choose “blank.” 
•	 Before you paste anything, from the PowerPoint menu options, under the 

Design tab, select “Page Setup.”
•	 In Page Setup, set 32 in. width and 24 in. height or 24 in. width and 32 in. 

height. 
•	 Choose “OK.”
•	 From the PowerPoint menu options, choose “Paste.” 

	 If using an older version of PowerPoint:

•	 Choose “Blank Presentation,” then “OK.” 

•	 Choose the icon showing a completely blank slide (or page). 
•	 Choose “OK.” 
•	 Under the File menu options, choose “Page Setup.” 
•	 In Page Setup, set 32 in. width and 24 in. height or 24 in. width and 32 in. 

height. 
•	 Choose “OK.” 
•	 From the PowerPoint menu options, choose “Edit, Paste Special.” 
•	 Choose “Picture (Enhanced Metafile).”

4.	 Select the image you pasted into PowerPoint. When you click on the image, 
it will show small squares on all four corners. These are handles. Hold down 
the shift key and use the corner handles only to resize your image. (Using 
the corner handles to adjust size maintains the proper proportions.)

5.	 Under the File menu option, choose “Save As.”

6.	 In the “Save As” dialog box, choose “Tag Image File Format (*.tif, *.tiff)” 
from the Save As Type drop-down list. Give the file a name and click “Save.” 
PowerPoint will ask if you want to save all slides or the current slide only; 
choose to save the current slide.
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Converting
Word Graphics

Below are steps for converting figures created in Microsoft Word into .TIF files. 
For additional information see Formatting Figures.

1.	 In Word, select the image to be converted.

2.	 If using Word 2007:

•	 From Word’s menu options, choose “Copy.”

	 If using an older version of Word:

•	 From Word’s menu options, choose “Edit,” then “Copy.”

3.	 Minimize Word; open PowerPoint.

4.	 If using PowerPoint 2007:

•	 On the Home tab, click “layout” and choose “blank.” 
•	 Before you paste anything, from the PowerPoint menu options, under the 

Design tab, select “Page Setup.”
•	 In Page Setup, set 32 in. width and 24 in. height or 24 in. width and 32 in. 

height.  
•	 Choose “OK.”
•	 From the PowerPoint menu options, choose “Paste.” 

	 If using an older version of PowerPoint:

•	 Choose “Blank Presentation,” then “OK.” 

•	 Choose the icon showing a completely blank slide (or page). 
•	 Choose “OK.” 
•	 Under the File menu options, choose “Page Setup.” 
•	 In Page Setup, set 32 in. width and 24 in. height or 24 in. width and 32 in. 

height.  
•	 Choose “OK.” 
•	 From the PowerPoint menu options, choose “Edit, Paste Special.” 
•	 Choose “Picture (Enhanced Metafile).”

5.	 Select the image you pasted into PowerPoint. When you click on the image, 
it will show small squares on all four corners.  These are handles. Hold down 
the shift key and use the corner handles only to resize your image. (Using 
the corner handles to adjust size maintains the proper proportions.)

6.	 Under the File menu option, choose “Save As.”

7.	 In the “Save As” dialog box, choose “Tag Image File Format (*.tif, *.tiff)” 
from the Save As Type drop-down list. Give the file a name and click “Save.” 
PowerPoint will ask if you want to save all slides or the current slide only; 
choose to save the current slide.
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Book Organization

Manuscripts should be double-spaced and in a single-column format on 8 1/2 by 11 
in. (126 by 279 mm) or A4 sheets, with 1 in. (25 mm) margins. 

Authors may submit artwork or suggestions for cover design, but final cover 
designs are the  discretion of ASHRAE.

Title Page
Includes complete title of document, research project number if applicable, and 
author names in desired order. 

Table of Contents (TOC)
Lists any front matter and each chapter in order.

Foreword
Optional; usually written by someone other than the author.

Preface and Acknowledgments
This section may acknowledge special assistance, including sources of financial 
aid, as well as the help of ASHRAE technical committees, individuals, or other 
groups. 

Introduction
This section should contain an overview of the document and general background 
information. The definition of the problem should be set in the appropriate frame-
work for the solution that will follow in the main body of the text.

Chapters
Most books are organized in chapters, which should have short, descriptive titles. 
The material should be presented in a logical order that is easy to follow, keep-
ing the prospective audience in mind. Authors may use sections with appropriate 
subtitles within chapters. 

Reports of experiments should include an estimate of uncertainty and an error 
analysis. Any results described should include qualifications, limits to the accu-
racy of tests and calculations, and other problems.

There should be a conclusion to the book, which should list conclusions and 
summarize the significance of the work as clearly and concisely as possible. 

Nomenclature
When equations are used extensively, the author should consider having a spe-
cial nomenclature section.

References and Bibliography
ASHRAE’s preferred method of citation, widely used in scientific texts, is the 
author-date method. 

Appendices
Appendices may include supporting data, sample calculations, derivations of com-
plicated mathematical equations, and detailed description of apparatus. 

Index
Authors will be asked to submit a list of words that will be compiled to create 
an index.
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Paper Organization

For formatting guidance, authors may use the Authors’ Template. 

Title
Titles must be concise but descriptive. Multipart papers must be labeled as Part I, 
Part II, etc. in the title.

Abstract
Abstracts should be between 100 and 200 words and concisely state the nature of 
the research, methods, major findings, and conclusions. It must be included in the 
body of the paper and  uploaded to Manuscript Central in the “Abstract” section.

Introduction
Introductions should contain general background information, literature review, 
and/or events that led to the work reported.

Body
The body should include, in order, experimental designs, test procedures, theo-
retical consideration, and results. Sections with appropriate subheadings should 
describe the test equipment, measurements, observations, and mathematics 
needed to perform the experiments.

Discussion
Results described in the preceding section should be discussed here, including quali-
fications, limits to the accuracy of tests and calculations, and other problems.

Conclusion
This section should list conclusions and summarize the significance of the paper 
as clearly and concisely as possible. 

Acknowledgments
Acknowledges special assistance. Persons mentioned should be identified.

Nomenclature
Use a special nomenclature section when equations are used extensively.

Appendices
Appendices may include supporting data, sample calculations, derivations of 
complicated mathematical equations, and detailed description of apparatus. 
Material in the appendices count in the page and figure limitations.

Computer Programs
Lengthy programs or printouts are only approved under exceptional circumstances. 

References and Citations
See References and Citations.

Figures and Tables
Figures and tables duplicated for units purposes count as a single figure when 
determining the maximum number of figures. Figures may be inserted into the 
MS Word text file for the review process only—do not insert figures into the Word 
file for final submission.

http://xp20.ashrae.org/Manuscript/AuthorsTemplate.doc
http://mc.manuscriptcentral.com/ashrae
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Document 
Formatting

For the final stage of a manuscript, only a Microsoft® Word for Windows file 
free of conditional text, line numbers, track changes, and cross-references should 
be submitted. Pages should be numbered consecutively with the author’s list as 
page one.

See References and Citations
See Formatting Figures
See Formatting Tables
See Formatting Equations 

Text

Manuscripts should be double-spaced and in a single-column format on 8 ½ by 
11 in. (216 by 279 mm) or A4 sheets, with 1 in. (25 mm) margins.

Headings

ASHRAE publications provide for three levels of headings. If a fourth level is 
needed, use the third-level heading with only the first word capitalized. 

Lists

Indent items in a list, preceded by a number and period. 

EXAMPLE:
The HVAC system was designed to accommodate the following:

placement of research equipment and walls anywhere in the laboratory 1.	
without major modification
minimal energy consumption2.	

Short listed items may be indented and preceded by a bullet.

EXAMPLE:
... are the following:

relative equipment first cost,•	
relative future cost of gas and electric energy, and•	
relative amounts of heating and cooling loads.•	

Separate items in a list within text using numbers in parentheses.

EXAMPLE:
... the following: (1) relative equipment first cost, (2) relative future cost of gas 
and electric energy, and (3) relative amounts of heating and cooling loads.

Numbers

Always use numeric figures with scientific and mathematical abbreviations:

4 ft, 12 in., 2 m, 3 m•	 2

Use only Arabic numbers.•	
Spell out the numbers one to ten in the text; use the numeral for any •	
number over ten.
Four-digit numbers need no comma (1200).•	

Acronyms

Acronyms should not be used without first giving the full expanded name. 

EXAMPLE:
“…measurement of the entering water temperature (EWT). Record the EWT for 
each….”
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References and 
Citations

References

A reference list is composed only of works cited in the text, and a bibliography 
is a general reading list—the two should not be combined. 

Do not write titles from memory.•	
Verify all references against the source and be sure that the authors’ •	
names are spelled correctly, that the title is written as it appears in print, 
and that correct volume, issue, and page numbers and dates are listed.
Use the most current edition of a •	 reprinted book whenever possible.
The reference list at the end of the manuscript should not be numbered.•	
Entries are arranged in alphabetical order, •	 chronologically for a particu-
lar author or group of authors.
All authors are •	 listed in a reference list entry. Any “a” or “b” designa-
tions that were used in the text to differentiate references to more than 
one publication by the same author with the same date should also be 
included in the reference list entries. 

Citations

ASHRAE’s preferred method of citation, widely used in scientific texts, is the 
author-date method.

In the text, cite a source by enclosing the author’s name and the date •	
(year) of publication in parentheses.

EXAMPLE: “... of such flow were clearly defined (Bailey 1951); how-
ever, ...”

Two authors’ names may be included; for three or more, use “et al.” after •	
the first author’s name.

	EXAMPLE: “... a feeling of thermal comfort may be associated with 
phenomena other than thermal conditions alone (Winakor and Foster 
1978; Woods et al. 1982).”

In situations where there are references to more than one publication •	
by the same author or group of authors with the same date, differentiate 
between the works by adding “a”, “b”, etc. after the date.

		  EXAMPLE: “as cited in previous studies (Carey et al. 2001a, 2001b).”

If the author’s name has just been mentioned, only the date need be •	
inserted in parentheses.

		  EXAMPLE: “... were clearly defined by Bailey (1951); however, ...”

If the “author” is an organization, use its acronym.•	

		  EXAMPLE: (ASHRAE 1982)
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Sample References

Journal Article
Arun, M., and E.G. Tulapurkara. 2005. Computation of turbulent flow inside an 

enclosure with central partition. Progress in Computational Fluid Dynamics 
5:455–65.

Standards
ASHRAE. 2001. ANSI/ASHRAE Standard 52.2-2001, Method of Testing Gen-

eral Ventilation Air-Cleaning Devices for Removal Efficiency by Particle 
Size. Atlanta: American Society of Heating, Air-Conditioning and Refrig-
eration Engineers, Inc.

ASHRAE Handbook
ASHRAE. 2005. 2005 ASHRAE Handbook—Fundamentals. Atlanta: American 

Society of Heating, Refrigerating and Air-Conditioning Engineers, Inc.

Book
Axley, J. 2006. Ventilation Systems: Design and Performance, 2nd Ed. Chap-

ter 4.3, Macroscopic methods. H.B. Awbi, ed. London: Taylor & Francis 
Books, Ltd.

Report
Emmerich, S. 1997. Use of computational fluid dynamics to analyze indoor air 

quality issues. Report NISTIR 5997, National Institute of Standards and 
Technology, USA.

ASHRAE Transactions
Chen, Q., and Z. Jiang. 1992. Significant questions in predicting room air mo-

tion. ASHRAE Transactions 98(l):929–39.

Conference Proceedings
Dhinsa, K., C. Bailey, and K. Pericleous. 2005. Turbulence modelling for elec-

tronic cooling: A review. Proceedings of the 7th International Conference 
on Electronics Materials and Packaging, Tokyo, Japan, 5:275–81.

Software
LBNL. 1993. DOE-2, Version 2.1E. Lawrence Berkeley National Laboratory, 

Berkely, CA.

Seminar or Presentation at a Conference
Lu, D.W., X.N. Xu, H.B. Wu, and X. Jin. 2005. A permanent magnet magneto-

refrigerator study on using Gd/Gd-Si-Ge alloys. First International Confer-
ence on Magnetic Refrigeration at Room Temperature, September 27–30. 
Montreux, Switzerland.

Internet
Rice, K. 2006. DOE/ORNL heat pump design model, Mark VI Version. www.ornl.

gov/~wlj/hpdm/MarkVI.shtml.

Personal Communication
Zimm, C.B., V.K. Pecharsky, K.A. Gschneidner, Jr., S.A Nikitin, and A.M. 

Tishin, with Astronautics Inc., Madison, WI. Telephone conversation with 
the author, April 17, 2006.
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and that the manuscript is an original work.  In consideration of ASHRAE’s publication of the manuscript, the author assigns 
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